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Пособие предназначено для студентов 1-2 курсов кафедры астрономии и 
космической геодезии, специальность "Астрономия". 

Использование программного пакета Origin существенно облегчает 
современному ученому работу по представлению результатов своей работы в 
графическом формате. Первая часть пособия посвящена начальным вопросам 
работы с программным пакетом Origin. В данной части содержится 
информация об основных возможностях рассматриваемого программного 
продукта, рассматриваются начальные этапы работы, описаны процедура 
построения графиков и некоторые возможности обработки данных.  
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Введение 
Отображение результатов исследования на графиках и 

таблицах, подготовка рисунков и диаграмм для отчета или 
выступления – все это является одним из важнейших элементов 
работы современного ученого. Способов представить результаты 
существует множество, но одним из самых информативных 
является представление результатов с помощью рисунков и 
графиков. Для этого можно использовать разнообразные 
графические пакеты и инструменты – выбор за исследователем.  

Программный продукт Origin является одним из наиболее 
мощных средств графического представления результатов. Кроме 
того, этот пакет позволяет не только просто строить те или иные 
графики и оформлять их в соответствии с желанием автора, он 
также позволяет проводить и математическую обработку 
результатов: искать зависимости в данных, проводить численное 
дифференцирование и интегрирование, осуществлять 
интерполяцию и экстраполяцию, проводить необходимые 
преобразования данных непосредственно в самой программе. 

Конечно, в плане графики и ее возможностей этот продукт 
будет уступать таким программам, как например, Coral Draw, в 
плане математической обработки он может уступать таким широко 
распространенным пакетам как Mathematika, MathCAD, Maple. Но 
так как основное предназначение рассматриваемого программного 
продукта – графическое отображение данных, то именно в этом 
компоненте по совокупности простоты использования и 
представляемым возможностям Origin заметно превосходит все 
перечисленные программы.  

Помимо описываемой в данном пособии программы Origin, для 
обработки данных и представления их в наглядном и удобном виде 
в научном мире используются и другие программы, например, 
GNUplot, SmartDraw. Тем не менее, пакет программ Origin широко 
распространен в научной среде и очень часто используется 
учеными при оформлении своих работ и статей. В этом нетрудно 
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убедиться при внимательном ознакомлении с иллюстрациями во 
многих журналах: Astrophysical Journal, Physical Review, 
Астрономический журнал, Оптика и Спектроскопия, 
Астрофизический Бюллетень и т.д. 

Origin является программой, разработанной под операционные 
системы семейства Microsoft Windows, и поэтому имеет интерфейс, 
присущий большинству Windows-приложений. Кроме того, он 
совместим с некоторыми программными продуктами линейки 
Microsoft Office, например, с табличным процессором Microsoft Excel, 
что позволяет, в частности, легко осуществлять импорт/экспорт 
данных между этими программами. 

Данное пособие не претендует на полное описание всех 
возможностей и особенностей программного продукта Origin. Это 
крайне трудно сделать, да и, пожалуй, в этом нет необходимости. 
Мы рассмотрим основные аспекты работы с программой: способы 
ввода данных, построение графиков, некоторые элементы 
обработки данных, в том числе и прямо на графике. Для более 
подробной информации можно обратиться в раздел справки (Help) 
или на сайт фирмы-разработчика OriginLab Corporation – 
www.OriginLab.com – где можно найти и демо-версию программы, 
и подробное описание ее возможностей. Более того, мы почти не 
будем касаться математической основы встроенных в программу 
инструментов обработки – это далеко выходит за рамки пособия. 
При необходимости всегда можно обратиться в раздел справки 
(Help), где есть краткое описание используемых при обработке 
данных процедуры или метода, а если этого будет недостаточно, то 
и к соответствующей литературе из той или иной области 
математического анализа. 

Описание программного продукта Origin будет проводиться на 
основе версий 6 и 7, наиболее распространенных на данный 
момент. Интерфейс более новых версий немного отличается, 
появляются дополнительные опции, но основные возможности и 
инструменты остаются практически без изменений, поэтому 
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пользователь без особых проблем сможет разобраться с новой 
линейкой программ. 

К сожалению, данный программный продукт не 
русифицирован: команды меню, контекстные подсказки, раздел 
справки – вся эта информация представлена на английском языке. 
Конечно, современный ученый, как правило, владеет английским 
достаточно хорошо, и вполне может обходиться без подсказок на 
русском языке. Тем не менее, при описании пунктов меню, вкладок в 
диалоговых окнах, команд мы, помимо названий по-английски, 
будем стараться давать соответствующее название по-русски (там, 
где это возможно). 
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1. Начало работы 
Запуск программного продукта Origin ничем не отличается от 

запуска абсолютного большинства Windows-приложений. Его можно 
осуществить и с помощью пиктограммы в панели "Быстрого запуска" 
на "Панели задач", и с помощью ярлыка на "Рабочем столе", и 
стандартным образом через меню Windows: Пуск -> Все программы 
-> Origin. Кроме того, автоматический запуск программы происходит 
при открытии файлов типа "Origin Graph" – т.е. файлов с 
расширением .opj или файлов старых версий .org (если, конечно, 
программный продукт Origin установлен на вашем компьютере). 

Если запуск программы Origin произведен впервые, то может 
появиться диалоговое окно, в котором потребуется ввести 
регистрационные данные и т.п. Будем полагать, что это все 
сделано, поэтому после запуска программы появится окно с новым 
(пустым) проектом (рис.1). 

Как уже упоминалось, интерфейс программы практически 
ничем не отличается от интерфейса большинства Windows-
приложений – основное содержание вкладок меню File (Файл), Edit 
(Редактирование), Help (Помощь) такое же, что и большинства 
программ. Поэтому в описании работы с программой мы не будем 
касаться вопросов, связанных с открытием и сохранением файлов, 
копированием и вставкой данных, настройкой печати и 
предварительным просмотром страницы и т.п., так как полагаем, что 
все это пользователю известно. 

При первом запуске программы все ее настройки (по 
умолчанию) являются стандартными. При необходимости, их можно 
изменить и настроить интерфейс программы под конкретного 
пользователя, но в данном описании мы будем придерживаться 
настроек "по умолчанию". Процедура изменения настроек 
отображения меню, наборов пиктограмм, сохранение шаблонов и 
т.п. будут описаны в соответствующей главе. 
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Помимо строки меню, где кроме упоминавшихся вкладок 
присутствуют и другие, специфические для Origin вкладки, в 
открытом окне под панелью главного меню имеются две панели с 
набором пиктограмм быстрого вызова/запуска той или иной 
команды или опции. Верхняя из панелей всегда активна, нижняя 
панель становится активной при работе непосредственно с 
графиками. При наведении указателя мыши на любую из 
пиктограмм, появляется название пиктограммы, из которого, как 
правило, становится понятным ее назначение. 

Рис. 1. Вид окна программы в начале работы 

Кроме того, в режиме работы с графиками немного меняется 
строка главного меню – при работе с числовыми данными в 
Worksheet (Таблица данных) в строке главного меню имеются 
вкладки Plot (Построение графика) и Column (Колонки), а при 
работе с графиками эти вкладки заменяются на Graph (График) и 
Data (Данные). 
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В нижней части окна имеется область, в которой слева 
показано дерево файлов, связанных с данным проектом (в самом 
начале работы она будет пустой), а справа – представлен список 
окон, имеющихся в данном проекте (в начале работы там будет 
содержаться только одно окно, которое по умолчанию носит 
название Data1). 

Любое из окон, будь то таблицы с данными или рисунки, можно 
переименовать. Если этого не делать, то Origin автоматически 
нумерует таблицы данных (Data1, Data2, …) и графики (Graph1, 
Graph2, …). Исключение составляет только наименование таблиц с 
данными при импортировании данных – в этом случае, как правило, 
название таблицы совпадает с первой частью названия 
импортируемого файла. 
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2. Ввод данных 
Для построения графика, нам понадобятся некие числовые 

данные. Ввести данные можно несколькими способами. Самый 
простой способ – введение данных вручную, заполняя 
соответствующие ячейки в таблице. 

При вводе данных следует обратить внимание на два 
момента. Во-первых, если после ввода данных в ячейку не была 
нажата клавиша Enter (Ввод), или не осуществлен переход в другую 
ячейку таблицы данных (стрелками или нажатием левой кнопки 
мыши) данные из такой ячейки не будут восприниматься Origin при 
построении графика. Более того, после построения графика они 
исчезнут из таблицы данных. Соответственно, это относится и к 
случаю, когда нужно отредактировать данные в уже имеющейся 
таблице – изменения будут восприняты только после нажатия 
клавиши Enter (Ввод) или перехода в другую ячейку.  

Во-вторых, следует внимательно отнестись к вводу нецелых 
числовых данных. В нашей стране традиционно принято отделять 
целые и дробные части чисел запятой, тогда как в большинстве 
западных стран (в частности, США, странах ЕС) это отделение 
производится точкой, а запятые используются для облегчения 
восприятия разрядов числа, например, 1,234,567.89 – это 
1234567,89 в привычном для нас понимании. По умолчанию Origin 
использует в качестве разделителя тот разделитель, который 
установлен при настройке операционной системы. Поэтому при 
вводе числовых данных прежде всего следует убедиться, что эти 
данные воспринимаются правильно. 
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При необходимости, тип разделителя можно поменять. 
Сделать это можно либо изменив настройки операционной системы 
(это зависит от версии ОС, примерный путь Пуск -> Панель 
управления -> Язык и региональные стандарты), либо зайдя в пункт 
меню Tools (Инструменты), строка Options (Опции) на вкладке 
Numeric Format (Числовой формат) выбрав параметр Separators 
(Разделитель). По умолчанию стоит Windows Setting (т.е. в 
соответствии с настройками ОС), а в выпадающем окне можно 
выбрать необходимое (рис. 2). 

 

Рис. 2. Окно Options в пункте меню Tools (Инструменты) 

При вводе очень больших и очень малых чисел можно 
использовать так называемый научный формат данных, т.е. 
записывать число в виде: 1230000 = 1.23е6 или 0.00123 = 1.23е-3, 
хотя Origin может это сделать и сам, произведя необходимые 
преобразования после ввода данных. Также следует учесть, что 
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число с очень большим количеством значащих цифр после запятой 
(безразлично, в каком формате – обычном или научном) будет 
округлено в соответствии с заданной в настройках программы 
точностью. По умолчанию это 5 цифр после запятой, но это можно 
изменить в том же самом пункте меню Tools (Инструменты), строка 
Options (Опции) на вкладке Numeric Format (Числовой формат) 
задав нужное значение параметра Number of Decimal Digits. 

Ввод значений вручную при современных объемах данных 
встречается крайне редко. Поэтому обычно используются 
стандартные для семейства ОС Windows команды копирования и 
вставки, либо осуществляется импорт нужных данных из файла.  

Исключением, пожалуй, является возможность открытия 
файла Excel как таблицы с данными Worksheet (осуществляется 
стандартным образом через меню File -> Open Excel). При открытии 
можно выбрать, в каком виде будут доступны эти данные – как 
данные в таблице, или открыты как лист Excel внутри программы 
Origin, что позволяет проводить некоторые вычисления 
(недоступные в Origin, как, например, работа с матрицами), 
используя возможности табличного процессора Excel. 

Необходимые данные можно ввести с помощью команды 
Import в меню File (рис. 3). Тип импортируемого файла можно 
выбрать в выпадающей вкладке (поддерживается большое 
количество типов файлов, в том числе возможен и импорт из баз 
данных), но, как правило, информация в файлах содержится в 
ASCII-формате, т.е. в виде обычных чисел, букв. Стандартными 
форматами ASCII-файлов Origin считает .dat, .txt, .csv, но выбирая 
произвольный тип (*.*) можно открыть любой файл.  

Следует обратить внимание, что импорт данных происходит в 
активную таблицу, при этом предыдущие данные (там, где на них 
накладываются новые) теряются. Поэтому при импорте новых 
данных, если есть необходимость сохранить старые, следует 
создать новую таблицу данных через меню File -> New -> 
Worksheet, или выбором соответствующей пиктограммы. 
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Рис. 3. Импорт ASCII-файлов 

 

При открытии файлов в диалоговом окне, где нужно указать 
путь к файлу, имеется вкладка Options, в которой можно задать 
параметры преобразования данных, которые будут использоваться 
при открытии файла (рис.4). Это может  оказаться необходимым, 
когда данные внутри импортируемого файла не имеют 
разделителей, или этот разделитель (delimiter) – необычный. Origin 
легко распознает такие разделители как пробел (Space), запятую 
(Comma), символ табуляции (Tab), с другими разделителями могут 
возникнуть сложности. Если разделителей нет вообще, то можно 
задать с помощью переключателя Fixed, col widths фиксированную 
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ширину каждого столбца вводимых данных. К этой же самой 
вкладке можно добраться прямо из меню: File -> Import -> ASCII 
Options.  

Настройки импорта файлов будут сохранены до тех пор, пока 
не будут произведены новые изменения, или до закрытия файла. 
После повторного открытия файла настройки, если они не были 
сохранены в шаблонах (об этом в соответствующей главе части II), 
будут автоматически сброшены к настройкам "по умолчанию". 

 
Рис. 4. Окно настройки параметров импорта ASCII-файлов 
 

Помимо одиночного ASCII-файла можно открыть сразу 
несколько – в открывшемся диалоговом окне после выбора команды 
File -> Import -> Multiple ASCII следует выбрать нужные файлы 
командой Add (Добавить). 

И, конечно же, не стоит забывать о нюансах, связанных с 
разделителем целых и дробных разрядов, а также с необходимым 
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количеством значащих цифр. Поэтому при подготовке данных для 
последующей обработки, как правило, подобные требования 
учитываются. Например, при написании программ используется 
форматированный вывод; в имеющихся файлах с данными меняют 
запятые на точки (если это необходимо) и т.д. 
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3. Преобразование данных внутри таблиц 
Импортированные данные располагаются в окне таблицы 

данных (Worksheet) в том порядке, в каком они были расположены в 
импортируемом файле. Колонки обычно нумеруются буквами 
латинского алфавита (A, B, C и т.д.), но могут нумероваться и 
комбинацией буквы и цифры (В2, С3, D7 …), если, например, в 
импортируемом файле содержится большое количество столбцов с 
данными. 

Если импортируемый файл имеет так называемую "шапку" – 
отличающуюся от числовых данных текстовую часть (например, 
описание структуры файла, название столбцов), то при импорте 
Origin может использовать эту информацию как название колонок 
или подписей столбцов. 

По умолчанию первая их колонок автоматически помечается 
меткой Х, все остальные – Y, что соответствует названию осей, к 
которым Origin будет соотносить данные из колонок при построении 
графика. Изменить метку (можно вообще ее удалить), а также 
провести другие преобразования с колонкой и данными в ней, 
можно, перейдя в меню управления колонкой. Это можно сделать, 
выделив нужную колонку (щелкнуть левой кнопкой мыши на 
заголовке) и, зайдя в пункт меню Column (Колонка), выбрать 
нужную команду. Из того же меню можно добавить новую колонку 
(это можно также сделать с помощью соответствующей 
пиктограммы на панели), переместить колонку в нужное место 
среди столбцов данных. 

Но более функциональным является расширенное меню 
управления колонкой, добраться до которого можно щелчком 
правой кнопки мыши на заголовке колонки. Здесь, помимо уже 
упомянутого, можно, например, получить статистику по данным в 
колонке (открывается в отдельном окне), разбить данные по 
группам с указанным интервалом (это бывает нужно для 
статистического исследования выборок), нормировать данные 
(разделить данные на самое большое значение в колонке) и т.д.  



Графическое отображение данных с использованием пакета Origin 

17 

 

Выбрав в контекстном меню команду Properties (Свойства), 
можно попасть в меню свойств колонки (до этого можно добраться и 
через главное меню  Format->Column), где можно выбрать тип 
возможных данных колонки и их формат (если есть в этом 
необходимость). С помощью флага Apply to all columns to the right 
можно назначить установленные свойства данной колонки все 
остальным колонкам справа. Также в этом меню установкой флага 
Enumerate all to the right можно задать имена всех столбцов 
справа от колонки в виде (С1, С2, С3 и т.д.), где в качестве 
начальной буквы и цифры используется буква и цифра текущей 
колонки.  

Но самой полезной среди опций меню колонки является опция 
Set Column Values (Установить значения столбца). С помощью этой 
опции можно производить вычисления и преобразования данных в 
колонках.  

 
Рис. 5. Преобразование данных в колонке таблицы 

 

В открывающемся диалоговом окне (рис. 5) для необходимого 
диапазона данных (указывается диапазон номеров строк "от" и "до" 
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в поле For row) в выпадающем списке выбирается требуемая 
математическая функция (Add Function) и необходимые данные из 
соответствующего столбца (Add Column). Функцию можно задать 
сложную – т.е. сделать вложение одной функции в другую и т.д., но 
при этом следует внимательно отнестись к круглым скобкам, 
которыми ограничивается аргумент каждой функции. Поэтому 
удобно пользоваться командой Add Function (Добавить Функцию) в 
нужном месте математического выражения, так как при этом 
вероятность ошибиться с количеством открывающих и 
закрывающих скобок существенно меньше, чем при наборе функции 
вручную. Перед тем как вставить функцию в математическое 
выражение, во избежание ошибки, можно ознакомиться с кратким 
описанием выбранной функции в левой верхней части окна вставки 
(рис. 5). 

При задании непосредственно аргумента функции – 
собственно данных, которые нужно преобразовать – следует 
помнить, что эти данные нужно задавать в виде, например, Col(В), 
т.е. данные из столбца В. Если написать просто В, то никакие 
вычисления не будут произведены. Также можно упомянуть, что при 
вычислениях можно использовать индекс i, который соответствует 
номеру строки в таблице. 

При преобразованиях данных исходные значения могут быть 
потеряны. Поэтому удобно перед началом преобразований или 
вычислений создать новый столбец командой Add New Column(s) в 
меню или с помощью пиктограммы и все вычисления производить в 
новом столбце.  

Также стоит иметь в виду, что Origin позволяет производить 
вычисления и записывать результат в те же ячейки, из которой были 
взяты исходные данные (циклические вычисления). Например, при 
записи Col(A)=ln(Col(A)) значения в столбце А выбранной таблицы 
будут заменены на вычисленные значения натуральных 
логарифмов исходных величин. В табличном процессоре Excel, 
например, такое сделать невозможно. 
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Если в записи математического выражения имеется ошибка, то 
данные могут быть потеряны (это особенно важно в случае, когда 
результаты вычислений записываются в ячейки, откуда были взяты 
исходные значения). В этом случае можно отменить последнее 
выполненное действие с помощью команды Edit->Undo. Но сделать 
это нужно сразу же, так как если будет произведено еще какое-
нибудь действие, то отмена предыдущего действия станет  
невозможной. 
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4. Построение графиков 
Доступ к основным инструментам для построения графиков 

осуществляется через вкладку Plot главного меню. Количество 
стандартных вариантов построения самое разнообразное (рис. 6), 
но помимо этого существует еще библиотека шаблонов, доступ к 
которой осуществляется с помощью опции Template (Шаблоны) в 
данном меню.  

 
Рис. 6. Выбор вида графика 
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Тем не менее, наиболее часто используемыми видами 
отображения результатов являются три первых варианта 
построения графиков: Line (Линия), Scatter (Разброс), Line+Symbol 
(Точки, соединенные линией). Поэтому именно эти варианты и будут 
рассматриваться в качестве примера. 

После выбора вида графика, если какой-либо из столбцов, 
помеченный меткой Y в таблице с данными, оказался выделенным, 
Origin автоматически построит график, используя данные из 
выделенного столбца, и столбца с меткой Х (по умолчанию это 
самый первый столбец). Если было выделено несколько столбцов, 
то Origin  построит несколько зависимостей на одном рисунке. При 
этом график каждой из зависимостей будет иметь свой цвет (рис.7). 

 
Рис. 7. Пример построения графика 
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При построении Origin автоматически выбирает масштаб, 
устанавливает минимальное и максимальное значения шкалы 
вдоль каждой оси. Все это можно при необходимости изменить, но 
об этом речь пойдет в главе 6.  

Построить график можно и с помощью аналогичной команды 
Plot из контекстного меню, появляющегося при нажатии правой 
кнопки мыши на названии колонки.  

Однако далеко не всегда нужно построить график зависимости 
колонки с меткой Y от колонки с меткой Х. Может потребоваться 
обратная зависимость (правда, конкретно для такого случая 
предусмотрен механизм смены осей – Graph -> Exchange X-Y Axis), 
также может потребоваться построить графики зависимостей 
колонок с одинаковыми метками. Поэтому для доступа к 
диалоговому окну с расширенными возможностями расположения 
данных на графике следует снять выделение со всех столбцов 
активной таблицы. Для этого достаточно щелкнуть левой кнопкой 
мыши в любом месте окна таблицы (кроме заголовков столбцов). 

В этом случае после выбора вида графика появится 
диалоговое окно с расширенными опциями построения графика 
(рис. 8). 

Выбирая нужную таблицу с данными на выпадающей вкладке 
Worksheet в левом верхнем углу окна (по умолчанию будет 
выбрана та таблица, которая была активной к моменту начала 
построения графика), затем, выбирая нужный столбец в таблице, 
можно указать этому столбцу с данными его роль при построении 
данного графика. Для этого выбранный столбец с помощью кнопок 
управления вида <-> устанавливается на нужную позицию: его 
можно расположить вдоль оси Х или оси Y, выбрать этот столбец в 
качестве указателя бара ошибок вдоль той или иной оси и даже 
использовать данные из столбца в качестве подписей (L). 
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Рис. 8. Окно выбора столбцов для построения графика 

 

Если требуется построить несколько зависимостей на одном 
графике, то после нажатия кнопки Add и добавления выбранной 
зависимости в список построения – в нижней части окна (рис. 8)  – 
можно перейти к выбору данных для новой зависимости и т.д. 

В правой части диалогового окна построения графиков есть 
область Set X Values, предназначенная для задания параметра Х в 
случае, когда ни один из столбцов таблицы не выбран в таком 
качестве. Здесь можно выбрать начальное значение параметра Х и 
шаг его изменения. Следует отметить, что при обработке научных 
данных такая опция, скорее всего, вряд ли будет востребована. 

При необходимости на уже существующий график можно 
добавить данные для построения новой зависимости. Для этого в 
пункте меню Graph нужно выбрать опцию Add Plot to Layer, после 
чего откроется диалоговое окно выбора столбцов данных для 
построения графика. Т.о. эта опция аналогична использованию 
опции Add при первоначальном построении графика. 

Построение графиков 

24 

 

Следует отметить, что при добавлении новых данных на 
рисунок Origin автоматически перестраивает масштаб и размеры 
шкал для отображения всех данных на рисунке. Поэтому 
оформление графика (например,  для подготовки его к публикации), 
о чем пойдет речь в главе 6, следует начинать только после 
вынесения на график всех необходимых результатов. 

Также нужно отметить, что при изменении набора данных в той 
таблице (Worksheet), откуда были взяты данные для построения 
графика, эти изменения автоматически отразятся и среди 
построенных зависимостей. Т.е. удаление данных приведет к 
удалению соответствующих точек на графике, изменение данных – к 
смещению точек. При этом автоматическое изменение масштаба и 
перестройка области отображения на графике не происходят. 
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5. Работа с данными на графике 
После построения графика может возникнуть необходимость 

уточнить какие-либо данные для последующего исправления, 
получить новые значения для дальнейшего использования. Для 
этого можно использовать стандартные инструменты Origin, 
расположенные в виде пиктограмм под строкой главного меню. 
Точное расположение пиктограмм на панели меню зависит от 
настроек и версии программы, поэтому они могут располагаться в 
любом месте (над или под рисунком, сбоку на дополнительной 
панели т.п.). Поэтому при описании будет даваться название опции, 
которой соответствует пиктограмма (это название "всплывает" при 
наведении на пиктограмму указателя мыши), а там, где это 
возможно – вид самой пиктограммы. 

Так, например, можно увеличить или уменьшить 
отображаемый рисунок, используя опции Zoom In и Zoom Out  

. Развернуть рисунок на всю страницу (т.е. сбросить все 
изменения, связанные с увеличением или уменьшением рисунка) – 

с помощью опции Whole Page  .  

Если есть необходимость более подробно рассмотреть 
конкретную область рисунка, то удобнее пользоваться 

инструментом Enlarger (Увеличение) . После выбора этой 
пиктограммы следует нажать левую кнопку мыши, и, не отпуская ее, 
выделить интересующую область на графике. Подобное увеличение 
можно производить неограниченно. Возврат к исходному масштабу 
рисунка осуществляется двойным кликом по той же пиктограмме. 

Два следующих инструмента Screen Reader  и Data Reader 

 предназначены для снятия данных с графика. Инструмент 
Screen Reader дает значения координат х и у той точки, на которой 
он находится. Инструмент Data Reader предназначен для 
определения координат конкретной точки из числа точек, которые 
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были использованы при построении графика. В обоих случаях 
использования этих инструментов появляется дополнительное окно 
Data Display, в котором как раз и даются координаты. При этом в 
случае использования Data Reader дополнительно присутствует 
информация о местонахождении исходных данных: название 
таблицы, столбца (буквенное обозначение) и строки (число в 
скобках).  

Если положение какой-либо из точек на графике резко 
отличается от остальных, то информация, полученная с помощью 
данных инструментов, может пригодиться для проверки или 
исправления исходных данных.  

Следующий инструмент Data Selector  используется для 
выбора диапазона из всей области данных, представленных на 
графике. Это может пригодиться, например, при вычислении 
определенного интеграла в заданном диапазоне или при поиске 
аналитической зависимости среди данных в заданном диапазоне, не 
рассматривая все остальные точки. Для использования этого 
инструмента следует, после нажатия пиктограммы, ухватить 
указателем мыши появившиеся на рисунке стрелки, и, передвигая 
их, выбрать требуемый диапазон данных. 

Инструмент Draw Data  предназначен для нанесения на 
график данных вручную. С нанесенными на график данными можно 
работать, как с данными из таблицы, более того, возможны даже 
математические операции между этими группами данных. После 
нанесения дополнительных точек на графике в открытом проекте 
Origin создается таблица, в которой сохраняются результаты 
нанесения точек. При необходимости, эта таблица может быть 
активирована для дальнейшей работы.  

Подобный инструмент может использоваться, например, при 
проведении уровня континуума в спектре (рис.9). В результате 
нанесения уровня континуума на график и деления исходного 
ненормированного спектра (шкала по вертикали в некоторых 
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условных единицах, по горизонтали в ангстремах) на континуум, 
получится так называемый нормированный спектр (в котором 
уровень континуума соответствует 1), с которым обычно имеют дело 
астрономы (рис. 11). 

 
Рис. 9. Пример использования инструмента Draw Data  

при проведении континуума 
 

Само деление выполняется с помощью встроенного 
инструмента Origin: Analysis -> Simple Math (рис. 10). В 
открывшемся диалоговом окне выбирается блок данных, которые 
будем делить (в нашем случае это данные из таблицы А6670, 
колонка В), а также выбирается блок данных, на которые будет 
производиться деление (в данном случае это искусственно 
нанесенные данные, содержащиеся в созданной Origin таблице 
Draw1, колонка В). Кроме деления, конечно же, можно использовать 
и другие математические операции – это зависит от того, что 
необходимо сделать. 
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Рис. 10. Диалоговое окно инструмента Analysis -> Simple Math 

Поскольку в результате деления ненормированного спектра на 
уровень континуума получившиеся значения будут иметь величины, 
близкие к 1, тогда как исходные значения имели величины порядка 
нескольких сотен тысяч (см. шкалу по вертикали на рис. 9), то 
результат деления – нормированный спектр – на исходном рисунке 
отобразится в виде совершенно незаметной линии вдоль оси Х. Для 
того, чтобы увидеть получившийся спектр, нужно изменить масштаб 
шкалы вдоль оси Y (см. главу 6), после чего можно увидеть 
окончательный результат (рис. 11).  

 
Рис. 11. Результат деления – нормированный спектр 
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Следующий инструмент – Text Tool  – предназначен для 
создания надписей и комментариев. Причем этот инструмент, как и 
последующие 5, могут быть использован как при работе с 
графиками, так и с таблицами данных. 

Само диалоговое окно панели ввода текста имеет вид, 
показанный на рисунке 12. Требуемый результат отображения  
текста достигается выбором необходимых параметров. 
Предварительный результат отображается в нижней части 
диалогового окна, а после нажатия кнопки ОК – располагается в том 
месте графика или таблицы, которое было указано щелчком мыши 
при вызове данного инструмента. 

 
Рис. 12. Окно панели ввода текста 
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Следует отметить, что введенную надпись всегда можно 
исправить, вызвав диалоговое окно ввода текста двойным щелчком 
мыши на выбранной надписи. Положение надписи также можно 
изменить с помощью мыши, а также удалить совсем, если эта 
надпись уже не нужна. При работе в версии 7 программного 
продукта Origin диалоговое окно панели ввода текста отсутствует, 
но вместо этого имеется дополнительный набор пиктограмм на 
одной из панелей программы, выполняющих те же функции. 

При вводе текста можно использовать жирный шрифт (Bold 
Face), выделение курсивом (Italic), подчеркивание, верхние и 
нижние индексы, менять шрифт и цветовые схемы оформления. 
Особо следует отметить возможность набора греческих букв 
(пиктограмма с буквой Г) в надписи, а также возможность поворота 
надписи на любой требуемый угол (иногда это бывает необходимо). 

Также следует отметить, что при наборе текста на русском 
языке для правильного его отображения следует выбрать в 
качестве шрифта (в выпадающей вкладке) один из кириллических 
шрифтов (с пометкой Cyr). В противном случае текст на русском 
языке будет отображаться неверно. 

Возникающая на рисунке при построении графика "легенда" (в 
правом верхнем углу графика) представляет собой ту же надпись, 
параметры отображения которой можно изменять. Кроме того, эта 
"легенда" позволяет быстро вызвать диалоговое окно Plot Details 
(см. рис. 13), в котором можно изменять вид и толщину линий, 
соединяющей точки с данными, форму и размер символов на 
графике и т.п. Диалоговое окно Plot Details можно вызвать и 
двойным щелчком непосредственно на точке или линии, 
представленной на графике. "Легенду" можно удалить, если она 
мешает; при необходимости, она может быть создана заново, при 

выборе пиктограммы  New Legend. 

Следующие 5 пиктограмм  предназначены 
для вызова инструментов рисования стрелок, линий, некоторых 
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геометрических фигур. Использование этих инструментов и 
модификация созданных с их помощью изображений (двойное 
нажатие левой кнопки мыши при наведении указателя на 
соответствующий объект) не вызовет у пользователя никаких 
затруднений. 

Инструмент Plot Details заслуживает того, чтобы ему была 
посвящена отдельная часть данной главы. Этот инструмент 
особенно востребован в случае, когда на одном графике имеются 
различные данные, которые нельзя смешивать между собой, но 
которые, тем не менее, требуется сравнить друг с другом. В этом 
случае каждому типу представляемых данных назначается свой 
символ или своя линия, для которых можно указать размер, тип, 
цветовую схему и т.п. Пример  использования этого инструмента 
приведен на рис. 13, где для одного типа данных в качестве 
символа  выбран черный квадрат размером 8х8 pixel.  

 
Рис. 13. Окно Plot Details 
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Поступая аналогично и назначая в качестве символа другому 
типу данных, например, красный кружок диаметром 8 pixels, на 
графике можно получить необходимое распределение (см. рис. 14) 
двух различных групп данных. Использование различных символов 
и различной окраски, позволяет построить рисунок, где однозначно 
можно понять, к какому типу данных относятся те или иные 
элементы графика, что, тем не менее, не затрудняет и общий 
анализ всех представленных данных в целом.  

 
Рис. 14. Пример выделения отдельных групп данных с 

использованием инструмента Plot Details 
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6. Оформление графиков 
Вид графика, который создается программой Origin по 

умолчанию (см. рис. 7), вряд ли удовлетворит требованиям к 
оформлению рисунков к научным статьям. Поэтому для приведения 
его в надлежащий вид (с указанием подписей к шкалам, созданием 
дополнительных осей и сеток и т.п.) используется соответствующее 
диалоговое окно. Вызов этого окна осуществляется двойным 
нажатием левой кнопки мыши на одной из осей, ограничивающих 
график, или шкал с числовыми подписями.  

 
Рис. 15. Диалоговое окно оформления графика. Вкладка Scale 

Данное окно (см. рис. 15) содержит несколько вкладок, каждая 
из которых отвечает за оформление того или иного элемента. 

Вкладка Scale (Шкала) служит для указания диапазона 
отображения данных на графике по горизонтальной и вертикальной 
осям (выбор соответствующей оси осуществляется в меню 
Selection). Здесь, помимо диапазона изменения данных (позиции 
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From и To),  можно указать шаг изменения числовых подписей 
(Increment) или количество основных делений в пределах диапазона 
изменений данных; количество промежуточных делений; тип шкалы 
(линейный, логарифмический и т.д.). 

 
Рис. 16. Вкладка Title & Format 

Вкладка Title & Format (Название и Формат) предназначена 
для включения / выключения отображения осей на графике. Для 
отображения соответствующей оси следует установить флаг Show 
Axis & Ticks в левом верхнем углу вкладки (см. рис. 16), 
предварительно выбрав нужную ось в меню Selection. По 
умолчанию отображаются только нижняя и левая оси на графике. 
После установки флага становятся доступными остальные 
инструменты: подпись заголовка оси; направление и размер 
делений; цветовая схема. 

Особо следует обратить внимание на нижнюю часть вкладки 
Apply To (Применить К): выбранную схему отображения элементов 
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графика можно распространить на отдельный слой на данном 
графике, на все слои или на все графики, открытые в данном 
проекте. Это позволяет оформить все графики, которые могут 
потребоваться при написании статьи, в одном стиле, не затрачивая 
лишнее время на оформление каждого графика в отдельности. 

Следующая вкладка – Grid Lines – позволяет добавить на 
график линии сетки (см. рис. 17). При этом размер линий сетки, их 
тип, цветовая схема – также могут быть выбраны по желанию 
пользователя. На этой вкладке также присутствует команда Apply 
To (Применить К): для облегчения оформления графиков. Можно 
включить на графике и дополнительные линии, например, линии 
Х=0 и Y=0, если в этом есть необходимость. 

 
Рис. 17. Вкладка Grid Lines 

Вкладка Break позволяет включить режим отображения 
разрыва (ставится флаг в левом верхнем углу вкладки). После этого 
все элементы вкладки становятся активными, и можно указать 
диапазон разрыва и некоторые параметры отображения данных. 
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Использование этой опции представляется целесообразным, если 
для лучшего отображения данных на графике есть необходимость 
исключить некоторый диапазон данных, не удаляя их совсем. 

Три оставшиеся вкладки относятся к оформлению подписей к 
делениям шкалы. Подписи можно включить для любой из четырех 
осей графика (вкладка Tick Labels на рис. 18), можно изменить их 
размер, используемый шрифт, угол поворота подписей. Из прочего 
списка опций следует упомянуть возможность использования 
элементов Prefix и Suffix. Число или символ, добавленные в 
данных полях, будут отображаться, соответственно, перед и после 
подписей к делениям. 

 
Рис. 18. Вкладка Tick Labels 
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7. Расположение графиков 
В программном продукте Origin предусмотрена возможность 

отображения нескольких графиков на одном листе. Для этого можно 
использовать инструменты, позволяющие располагать графики в 
разных местах страницы, использовать различные слои для 
отображения данных, делать выноски, 

Самый простой способ размещения нескольких графиков на 
одном рисунке состоит в использовании опции Merge all Graph 
Windows в пункте меню Edit (см. рис. 19) или выбор пиктограммы  

 в строке меню. 

 
Рис. 19. Опция Merge all Graph Windows 

Эта команда будет применена ко всем графикам данного 
проекта, которые не находятся в свернутом (Minimize) состоянии. 
При этом пользователю будет задан вопрос – следует ли сохранить 
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исходные графики. Так как процедура, вообще говоря, является 
необратимой, рекомендуется исходные графики сохранять. 

При использовании процедуры "склейки графиков" появится 
диалоговое окно, в котором можно указать, как именно нужно 
расположить графики на листе. Количество колонок и строк можно 
указать вручную. Если числа графиков на заполнение всех "ячеек" 
не хватит, Origin оставит эти области пустыми, изобразив только 
координатные оси. После указания количества колонок и строк 
появится диалоговое меню, в котором можно указать размеры 
отступов от края страницы для отображаемых графиков и величины 
отступов между самими графиками (см. рис. 20). 

 
 Рис. 20. Задание параметров расположения графиков 

Результат "склейки" на примере двух графиков представлен на 
рис. 21. С каждым из графиков по-прежнему можно работать в 
отдельности: изменять стиль оформления, делать подписи, убирать 
и добавлять данные и т.п. 

Каждый из графиков на объединенном листе располагается в 
своем слое (Layer). Доступ к настройкам отображения 
соответствующего слоя осуществляется двойным кликом на номере 
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слоя в левом верхнем углу листа (см. рис. 21) или выбором пункта  
Properties в контекстном меню, появляющемся после нажатия 
правой кнопки мыши в области графика. Здесь можно изменить 
размеры слоя и некоторые параметры его отображения, если в этом 
есть необходимость.   

 
Рис. 21. Результат объединения двух графиков 

При выборе пункта Plot Associations (например, с помощью 
двойного клика на номере соответствующего уровня) пользователь 
получает возможность добавить данные на выбранный график. Т.о. 
со слоем можно проводить ту же работу, что и с отдельными 
графиками. 
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Процедура "склеивания" графиков может быть полезна при 
отображении нескольких однотипных графиков на одном рисунке 
при подготовке, например, научной статьи. 

Рисунок, имеющий несколько слоев, можно разделить и на 
отдельные графики, и на отдельные слои. Для этого используются 

пиктограммы  и   соответственно. Следует отметить, что 
исходный рисунок при этом не сохраняется. 

При разделении на отдельные графики каждый из графиков 
будет отображен на отдельном листе, но при этом он будет иметь 
то же расположение на листе и те же размеры, какие он имел на 
исходном рисунке. При необходимости изменения размеров 
графика, его положения на листе это также можно сделать, перейдя 
к  настройкам отображения соответствующего слоя в левом 
верхнем углу листа (см. рис. 21) или выбором пункта  Properties в 
контекстном меню. 

При разделении на отдельные слои каждый из слоев будет 
отображен на том же самом рисунке. При этом пользователю будет 
предложено выбрать количество строк и столбцов при отображении 
слоев. 
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8. Построение простейших 3D-графиков  
Помимо построения графиков и зависимостей между двумя 

параметрами в программном пакете Origin предусмотрена 
возможность построения изображения трехмерных объектов.  

В качестве примера приведем построение изображения 
пирамиды, заданной координатами своих вершин: А1, А2, А3, А4. 

Для задания координат вершин потребуется три колонки в 
новом окне данных (Worksheet), причем одна из колонок должна 
иметь метку (Z). Для отображения только вершин пирамиды 
достаточно будет только 4 строк в таблице, а для прорисовки ребер 
пирамиды придется продублировать координаты вершин в 
измененном порядке: А1, А3, А2, А4 (см. рис. 22). При построении 
пирамиды с прорисовкой ребер сначала нужно выделить колонку с 
меткой Z, а затем выбрать на вкладке Plot команду 3D XYZ -> 3D 
Trajectory (см. рис. 23).  

 
Рис. 22. Пример исходных данных для построения 3D-объекта 
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Рис. 23. Выбор вида графика. 

В результате получим изображение объекта (см. рис. 24). 

С построенным рисунком можно проделать все те же действия 
по оформлению: изменение размеров шкалы по любой из осей, 
изменение заголовков осей, отображение сетки и т.п., как это 
делалось при построении обычного графика. 

Также следует отметить, что после построения 3D-объекта 
появляется дополнительная панель инструментов (по умолчанию 
она будет находиться вверху, под основными панелями 
инструментов – см. рис. 24), позволяющая поворачивать, наклонять, 
увеличивать или уменьшать данное изображение. Использование 
такого инструмента позволяет рассмотреть объект в разных 
проекциях, что позволяет получить лучшее представление об 
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объекте (кроме пирамиды можно построить и более сложные 
объекты, для которых такая опция будет весьма полезной).  

 

 
Рис. 24. Пример построения пирамиды с прорисовкой ребер 

Также в программном продукте Origin предусмотрена 
возможность построения 3D поверхностей. К сожалению, 
поверхность нельзя задать аналитической функцией вида z=f(x,y), 
как это можно сделать при построении плоской функции, 
выраженной в явном виде: y=f(x), а требуется использование 
отдельного инструмента – Matrix, о чем подробно будет сказано в 
части II. 
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9. Построение графиков функций 
В программном пакете Origin имеется полезный инструмент, 

позволяющий производить построение графиков функций, заданных 
в явном виде: y=f(x). Данный инструмент позволяет четко 
представить поведение интересующей функции в отдельных точках 
или областях, быстро получить значение функции в нужной точке, 
сравнить, насколько хорошо полученные результаты соответствуют 
той или иной теоретической аппроксимации и т.п. 

Для запуска инструмента построения функции можно 

воспользоваться пиктограммой  (New Function), или запустить 
этот инструмент с помощью цепочки команд основного меню 
программы: File –> New –> Function. 

Диалоговое окно Plot Details, необходимое для задания 
функции имеет вид, изображенный на рисунке 25. 

 
Рис. 25. Диалоговое окно построения графика функции  



Графическое отображение данных с использованием пакета Origin 

45 

 

Принцип задания функции такой же, как и при использовании 
опции Set Column Values, которая была описана в главе 3. Т.е. 
также можно выбирать необходимую математическую функцию из 
числа "встроенных", можно задавать сложную функцию (вложение 
одной функции в другую) и т.д. Отличием от уже упомянутой опции  
Set Column Values, которая используется при работе с числовыми 
данными в столбцах соответствующей таблицы (до построения 
графика), будет то, что в качестве аргумента функции используется 
переменная x (обязательно латинская буква!), а не конкретные 
числовые данные. Следует отметить, что при ошибке во вводимой 
формуле (пропущенный знак операции умножения "*", некорректная 
расстановка скобок, неправильное задание функции, использование 
русских букв в качестве аргумента) результатом будет появление 
"пустого" графика. При наличии "легенды" (обычно в правом 
верхнем углу графика) можно заново войти в режим Plot Details и 
произвести необходимые исправления (см. рис. 26). 

 
Рис. 26. Пример построения графика функции  
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При построении графика можно указать, по какому количеству 
точек будет строиться график функции (выпадающая вкладка 
Density в верхней части диалогового окна). Количество точек 
(плотность точек) можно задать выбором одного из стандартных 
значений (от 5 до 1000), но можно и задать вручную, в том числе и 
числом, больше чем 1000. Следует отметить, что повышение 
плотности точек целесообразно при построении графиков функций, 
имеющих точки разрыва (определенных не на всей числовой оси). 
При этом область вблизи точки разрыва или границы области 
определения функции оказывается более четко выраженной. 
Однако несоразмерное увеличение параметра Density может 
привести к некоторым задержкам при прорисовке графика функции, 
особенно при сложном виде функции.  

При построении графика функции Origin по умолчанию задает 
пределы размеров шкал вдоль осей х и у от 0 до 10. Поэтому 
график функции, даже если формула задана правильно, может и не 
отображаться на рисунке. Такое происходит, например, когда 
график функции лежит не в первой четверти, или диапазон 
значений функции лежит вне пределов интервала от 0 до 10 как по 
х, так и по у.  

В этом случае следует вручную задать необходимый диапазон 
значений для каждой шкалы, как это описывалось в главе 6. С 
графиком функции можно проделывать те же преобразования, как и 
с обычным графиком – преобразовывать, создавать надписи, 
изменять диапазоны значений, склеивать и т.п.   

При необходимости на одном и том же графике можно 
отобразить сразу несколько функций. Для этого нужно использовать 
опцию New Function, выбирая ее непосредственно на уже 
построенном графике. Origin автоматически нумерует все 
построенные функции, и при необходимости с помощью 
инструмента Plot Details (см. рис. 27) можно вернуться к требуемой 
функции и внести необходимые исправления или преобразования.  
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Рис. 27. Диалоговое окно Plot Details для нескольких функций.  

 
Рис. 28. Изменение стиля и толщины линии графика функции.  
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При активации вкладки Line в верхней части диалогового окна 
Plot Details (см. рис. 28) можно изменить толщину, тип и стиль 
линии графика соответствующей функции. Для лучшего 
отображения можно изменить и цветовую схему для одной или 
нескольких функций, как это показано на рис. 29. 

 
Рис. 29. Отображение нескольких функций на одном графике.  

График функции можно построить как на отдельном рисунке, 
так и  добавить в качестве линии сравнения к уже имеющимся 
точкам на готовом графике. Для этого используется команда Add 
Function Graph в пункте Graph основного меню.  

В появившемся окне Plot Details, помимо параметров 
отображения данных будет присутствовать и диалоговое окно для 
задания необходимой формулы, описывающей нужную функцию. 
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Результат добавления графика функции y = - 0.5 x  к уже 
построенным данным представлен на рис. 30. 

 
Рис. 30. Результат добавления графика функции.  

С данными, представленными на рисунке, с графиком 
функции можно работать по отдельности, преобразуя их по мере 
надобности. Но так как все эти данные принадлежат одному 
рисунку, то все изменения диапазона шкал вдоль координатных 
осей, включение и выключение разрывов и прочие операции, 
описанные в главе 6, будут влиять на отображение всех элементов 
рисунка – и на точечные данные, и на линию графика функции. 
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10.    Поиск простейших зависимостей 
При анализе полученных результатов часто возникает 

необходимость поиска зависимостей между данными или 
аппроксимация данных той или иной теоретической кривой. В 
программном пакете Origin для проведения такого анализа данных 
используется отдельный пункт меню Analysis (см. рис. 31) с 
обширным набором инструментов.  

 

Рис. 31. Пункт меню Analysis. 
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В данной части пособия мы рассмотрим только поиск и 
проведение наиболее простых математических зависимостей – 
линейной и степенной. Процедура проведения более сложных 
зависимостей, аппроксимация данных специальными функциями, в 
том числе проведение гауссиан и лоренцианов – все это будет 
рассмотрено в части II пособия. 

Поиск линейной зависимости между данными не представляет 
особой сложности. Для этого вызывается процедура Fit Linear в 
выпадающей вкладке меню Analysis. В результате использования 
этой процедуры на графике с данными появляется прямая линия, а 
также активируется окно представления результатов 
математической обработки Result Log (см. рис. 32). 

 Рис. 32. Результат поиска линейной зависимости. 
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Origin проводит обработку данных используя метод 
наименьших квадратов, поэтому в окне Result Log помимо 
собственно параметров A и B, характеризующих найденную 
линейную зависимость ( Y = A + B * X )  и их ошибок (Error) 
представлена и дополнительная информация: например, 
коэффициент корреляции (r) и среднеквадратичное отклонение 
(SD), что позволяет судить о корректности полученного результата. 

Особо следует обратить внимание, что Origin выполнит поиск 
заданной пользователем зависимости и построение 
соответствующей линии на графике вне зависимости от того, 
имеется ли такая зависимость или нет. На рис. 32. приведен пример 
такого построения: хотя очевидно, что никакой линейной 
зависимости между представленными данными быть не может, 
Origin выполнит запрошенную команду и проведет необходимые 
вычисления. Поэтому следует внимательно контролировать 
результаты аппроксимаций и вычислений в окне Result Log. В 
частности для рассмотренного примера величина 
среднеквадратичного отклонения (SD = 6.32317) однозначно 
свидетельствует о неправомочности проведения линейной 
зависимости для данного случая. 

 

Рис. 33. Диалоговое окно поиска полиномиальной зависимости. 
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В некоторых случаях зависимость может иметь вид полинома 
(степенной функции). Для поиска таких зависимостей используется 
процедура Fit Polynomial в выпадающей вкладке меню Analysis. 
При запуске этой процедуры появляется дополнительное 
диалоговое окно (см. рис. 33), в котором выбирается степень 
полинома, параметры Xmin и Xmax, ограничивающие область, в 
пределах которой будет осуществляться поиск зависимости. 
Установкой флага Show Formula on Graph можно вывести 
результат проведения зависимости в виде формулы 
непосредственно на график (аналогично созданию надписи на 
графике). 

При поиске зависимости можно указать заведомо высокую 
степень полинома. В этом случае некоторые найденные параметры 
полиномиальной зависимости в окне Result Log будут иметь 
пренебрежимо малые величины (см. рис. 34). В этом случае при 
окончательном анализе полученной зависимости их можно 
отбросить (руководствуясь, конечно, здравым смыслом). 

 

Рис. 34. Результат поиска полиномиальной зависимости. 
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В рассмотренном примере найденные параметры В1, В4, В5, 
В6 – оказываются очень малыми, по сравнению с остальными 
параметрами. Следовательно, с физической точки зрения, их можно 
отбросить при окончательном анализе найденной зависимости (см. 
рис. 35).  

 
Рис. 35. Итоговый результат поиска полиномиальной зависимости. 

Найденные зависимости наносятся на график, поэтому 
некоторые из них (например, ошибочно найденные) бывает 
необходимо удалить. Сделать это можно используя инструмент Plot 
Details, о котором подробно рассказывалось выше. Вызов этого 
инструмента осуществляется двойным кликом левой кнопки мыши 
на соответствующей линии. Для удаления ненужных данных 
следует нажать клавишу Del на клавиатуре и подтвердить 
выполнение этого действия. 
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Заключение 
В представляемой части I пособия рассмотрены основные 

элементы работы с программным пакетом Origin, предназначенным 
для математической обработки и графического представления 
данных.  

Использование этого программного продукта существенно 
облегчает работу по подготовке статей, докладов, позволяя 
наглядно отображать результаты проделанной работы. Поэтому 
пакет Origin часто используется в научной среде при подготовке к 
публикациям, выступлениям и т.п. 

В первой части пособия основной упор был сделан на 
наиболее значимые моменты работы с программным продуктом 
Origin, начиная от ввода и импорта данных и построения 
простейших графиков, и заканчивая процедурами поиска 
простейших зависимостей. 

Очень многие возможности рассматриваемого программного 
продукта остались за рамками данного пособия. Некоторые из них, в 
первую очередь имеющие приложение в астрономии 
(аппроксимация специальными функциями, интегрирование, Фурье-
анализ) будут рассмотрены в части II пособия. 
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